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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in June 2023

Sector Indices vs HSI / HSCEI

Index Name

HSI

MSCI China A 50 Connect Index

HS Mainland
Banks Index

Equity Index Futures Access Codes

Vendor

-0.1%

% Change

HS Mainland Banks

CES120 vs China Theme Indices

Index Name

FTSE A50 Index

CSI 300 Index

CES120 Index

+1.5%

+1.2%

+3.9%

% Change

CES 120 HSI HSCEI
Bloomberg BMWA CESA HIA HCA
Refinitiv O#HMBI: O0#HCHH: O#HSI: O#HCEL:
WIND MBIF CHHF HSIF HHIF
ET Net MBI CHH HSI HHI

Data Source: Bloomberg

As at 30 June 2023
Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products HSI Futures (YoY)
(2023 vs 2022)

Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)
280,000 - mmmmm ADV (L-Axis) - 200,000
HSI Futures 142,271 (-7%) 123,329 (+8%) 240,000 - Open Interest (R-Axis)
200,000 - [ 150,000
160,000 -
M - 100,000
Mini-HSI Futures 95,524 (-11%) 16,488 (+39%) 120,000 -
80,000 ~ - 50,000
40,000 -
0 - -0
HSI Options 24,210 (-6% 101,373 (-6% N OO NS
P £o%) £o%) S S T
HSI Futures (MoM)
Mini-HSI Options 13,129 (+5%) 23,006 (+71%)
Av erage Daily Volume Open Interest

(No. of Contracts)

200‘000 c ADV (L-Axis) (N(Z' of Contracts)

Open Interest (R-AXxis) '
HSI.Futures 3,915 (+50%) 41,527 (-21%) 150,000 - 1 l - 150,000
Options i l.
100,000 - - 100,000

HSI Volatility | L

0 (- 0 (- 50,000 50,000
Index Futures ©) ©)

01 o - -0
HSI Dividend 3338385888255
I 0, 0,

Point Index 88 (+203%) 9,521 (+2866%) 2029 | 5023
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2023

X

HSI Options (YoY)

Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)
' 1 ADV (L-Axis) - 400,000
Open Interest (R-Axis)
45,000 - - 300,000
30,000 - - 200,000
15,000 - - 100,000
0 L e e L 0
N o A 9 N
NN NN KN QD
DRI N
HSI Options (MoM)
Av erage Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)
45,000 -+ ADV (L-Axis) - 200,000
Open Interest (R-Axis)
- 150,000
30,000 M
- 100,000
15,000 -
- 50,000
0 - 0
sSoao2Qcsagas>Dc
3338285885285
2022 | 2023




Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description _ ’ . 21 32 130
liquid stocks listed in Hong Kong | e—HS|  —\HS| I e HS| Index — Tencent
Index Level 18,916.43 (As at 30 Jun 2023) 120 - HS.BC AIA
Meituan Baba
Index Volatility (30-Day Historical) | 30.1 20 - L 28 110 -
Index Avg. Day High-Low Range 243.50 (Jun 2023) 100
HSCE! Correlation (2023) 0.984 19 - L o4 90 -
80 -
Hang Seng Index Futures 18 0 70
Apr23  May-23  Jun-23 Apr-23 May-23 Jun-23

HK$50

Contract Multiplier

Notional Value (1 Contract) HK$0.95Mn (As at 30 Jun 2023)

Transaction Cost*

Stamp Duty NA

Call

Trading Fee HK$10 / contract

SFC Levy HK$0.54 / contract

Index Strike Price (‘000)
PRPRPRPRPEREERENNNNNWW

ONWAUIDNOOONMINIOND
oMM ERRR VO

Commission Rate Negotiable

Index Strike Price (‘000)

Margin as of 29 Jun 2023 HK$76,650

1 2
Open Interest (‘000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2023

X

Distribution of HSI Index Options Ol in Month-end

Put

012 3 456 7 829
Open Interest (‘000)



Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products ADV or*

(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) r 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
J - 600,000 i - 2,400,000
HSCEI Futures 192,731 (+5%) 628,555 (+3%) 200000 [ c00.000 100,000 [ 200,000
160,000 - ! 80,000 - ! !
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Fut SIS 10,337 (-24%) 5,469 (+8%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N ND O A 9 N g
. ) S S S S S S
HSCEI Options 48,046 (+7%) 1,204,328 (+5%) v
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mln-l HSCEI 3,874 (+11%) 23,701 (-15%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 700,000 80,000 - ADV (L-Axis) - 2,000,000

Opennterest (R-Axis)" | Open Interest (R-AXis)
220,000 - 600,000
HSCEI Futures 500000 60,0007 [ 1500000
. 35,186 (+81%) 934,779 (+27%) 165,000 - L 400,000
SERE ' 40,000 - - 1,000,000
110,000 - - 300,000 ' o
.. - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,161 (-15%) 84,483 (+47%) - 100,000
Futures Ll E— 0 0 0
598353 Soat>9cass>c
TE0cz 325858582283
2022 2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
Correlation with HSI, CES120 (2023)

Correlation with CSI300, FTSE A50
(2023)

Contract Multiplier

Notional Value (1 Contract)

Stam p Duty
Trading Fee

SFC Levy
Commission Rate

Margin as of 29 Jun 2023

Data Source: HKEX, Bloomberg

Comprises the largest and
most liquid H shares

6,424.88 (As at 30 Jun 2023)
34.9
95.34 (Jun 2023)

0.984,0.927

0.69,0.685

HK$50

HK$0.32Mn (As at 30 Jun 2023)

Transaction Cost*

N/A

HK$3.5 / contract
HK$0.54 / contract
Negotiable

HK$29,550

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 30 June 2023

X

110

105 -

100 -

Index Strike Price (‘000)

e HS| e HSCEI

95 T

1-Jun  8-Jun 15-Jun 22-Jun 29-Jun

Call

14.2
125
10.8
9.4
8.4
7.4
6.4
5.4
4.7
42 |
2.0

v

0 10 20 30 40 50 60
Open Interest ('000)

130 -

110 -

90 -

70

HSCEI & Top 5 Constituents

e HSCEI = Ping An
Tencent = CCB
Meitu Baba
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Distribution of HSCEI Index Options Ol in Month-end

Put
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7.4
6.4
5.4
4.7
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Open Interest ('000)



Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50

Volume
. . Akuna, Eclipse, I-Access, IMC, Maven, ~ (No. of Contracts)
Liquidity Providers ) .
Optiver 30.000 - ® Weekly HSI Options
25 000 m Weekly HSCEI Options
Transaction Cost* 20,000
Stamp Duty N/A 15,000
Trading Fee HK$10 / contract 10,000
SFC Levy HK$0.54 / contract 5,000
- . 0
Commission Rate Negotiable ©©0©OOOOOO0O0OOO0OOOOL oo o
AN O RIOIAMNIDOPDO IHMON DB O O
o N NN NNNANMm
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 20,000 - ==\ eekly HS| & HSCEI Options Call
L . Akuna, Eclipse, I-Access, IMC, Mawen, Weekly HSI & HSCEI Options Put
Liquidity Providers ) 16,000 -
Optiver
12,000 -
Transaction Cost* 8,000 -
Stamp Duty N/A 4,000 -
Trading Fee HK$3.5 / contract 0 —
© OO 0VOOOOO0DOOHOLODOOOODOO
SFC Levy HK$0.54 / contract TANBLONBOTANNITNOCRISIBLENRDS
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2023

X



Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures 6,818 (-13%) 27,733 (-18%) Single Stock Futures
Stock Options 632,651 (+8%) 9,138,276 (+18%) Single Stock Options 126
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
121000 7 mmmm ADV (L-Axis) . r 401000 800,000 - ADV (L-Axis) ~ 10,000,000 Stock Futures
| Open Interest (R-Axis - 35,000 Open Interest i
10,000 - 8,000,000
- 30,000 600,000 - s
8,000 - . 95000 6.000.000 * Products
6.000 - L 20000 400,000 - i > 3 A-shares ETFs futures contracts
4,000 | - 15,000 - 4,000,000 > Total 98 stock futures contracts
’ - 10,000 200,000 - - 2,000,000
2,000 il I - 5,000
0_| Lo o+t—+++++++—=1o0
N LB N D0 O NS
DNEE N N R
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) ~ (No. of Contracts) , (No. of Contracts) > 3 A-shares ETFs options contracts
_ mmmmm ADV (L-Axis) ) 800,000 - ADV (L-Axis) - 12,000,000 -
10,000 Opon mteroat (R-Ais) | 50:000 Open Interest (R-AKiS) > Total 126 stock options contracts
8,000 - - 40,000 ]
Pz, l | [ 600,000 /\/\/—)\ - 8,000,000 * Market Makers (MMs)
6,000 1 i F 30000 000 - > 3 types of market makers (PMM/ CQMM/
4,000 - 20,000 I QRMM)
200,000 4,000,000 > CQMM to provide 50 series continuous
2,000 - - 10,000 ' . P
guotations
01 0 0 > O > 0
S oahn > olc == O S oan C =5 c
333858882285 3388285838285
2022 2023 2022 | 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 30 June 2023
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 30 June 2023)

. Tracks the largest technology companies
naexescription . . Open Interest
listed in Hong Kong (No. of Contracts)
280,000 -~
Hang Seng TECH Index Futures & Options & Futures Options 240.000 -
Contract Multiplier HK$50 per index point 1
. 200,000 -
Notional Value (1 Contract) HK$196K (As at 30 June 2023)
No. of Liquidity Providers Options: 5 160,000 -
120,000 -
Transaction Cost* 80.000
Stamp Duty NA 3333385858535
Trading Fee HK$5.00 / contract < © z o> & = = 7
SFC Levy HK$0.54 / contract 2022 | 2023 |

Average Daily Volume (as of June 2023)
A\ .'

(No. of Contracts)

120,000 -
100,000 -
80,000 -
60,000 -
40,000 ~
20,000 -

0 -

855 3
L = < s

2022

2023

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest continue to growth
to Hong Kong-listed technology companies
Data Source: HKEX

* Exclude commission fees
Information for reference onlv

As at 30 June 2023
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index Average Daily Volume (as of June 2023)

. Balanced representation from 11 sectors
Index Description

of top 50 China A shares ADV
(No. of Contracts)

Index Level 2,031.93 (As at 30 June 2023) 20.000 -
Index Volatility (30-Day Historical) | 20.5

15,000
Index Avg. Day High-Low Range 19.66 (June 2023)

10,000
CSI300 Correlation (2023) 0.953

. 5,000

FTSE A50 Correlation (2023) 0.972

0

MSCI China A 50 Connect Index Futures

Contract Multiplier US$25 2022 | 2023 |

Notional Value (1 Contract) US$0.05Mn (As at 30 June 2023) Open Interest (as of 30 June 2023)
Average Quote Size US$0.25Mn (5 Contracts)

Open Interest
(No. of Contracts)

25,000 -
Transaction Cost*
Stamp Duty N/A 20,000 -
Trading Fee US$0.5 / contract
15,000 -
SFC Levy US$0.07 / contract
Margin as of 29 Jun 2023 US$2,870 10,000 — o o = - ole = - - _
> (&) 1] Q
5 2 o 23S ¢ =< 83
2022 | 2023 |
Sector-balanced exposure to China’s A-share market Risk management tool for diversified China portfolios

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 30 June 2023



MSCI Asia and Emerging Market Index Futures Performance

MSCI Asia and Emerging Market Index

Index Description

representation 38 DM and EM countries and

regional indices

MSCI Asia and Emerging Market Index Futures

Contract Multiplier
Notional Value (1 Contract)

No. of Liquidity Providers

Transaction Cost*
Stam p Duty

Trading Fee

SFC Levy

Average US$40
Average US$45K (As at 30 June 2023)
12

N/A
US$0.6-US$1.0 / contract
US$0.07 / contract

HKEX with the broadest suite of MSCI derivatives products
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 30 June 2023

Open Interest (As of 30 June 2023)

Open Interest
(No. of Contracts)

100,000 ~
90,000 -
80,000 -
70,000 -
60,000
5 @ a B8 2 Q|ls @ 5 5 > ¢
5 2 3 o0 2488 e s < &3
2022 | 2023 |
Average Daily Volume (As of June 2023)
ADV
(No. of Contracts)
30,000 -
20,000 -
10,000 -
0_
2022 2023

Volume and Open Interest continue to growth

12



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

488.92 (As at 30 June 2023)
20.5

3.59 (June 2023)

0.906

0.898

MSCI AxJ Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$49K (As at 30 June 2023)
US$0.24Mn (5 Contracts)

1.1 index points (June 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 29 Jun 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$1,900

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 30 June 2023

Open Interest (30 June 2023)

Open Interest
(No. of Contracts)

1,200 ~

1,000 -

800 -

600 -

400 -

200 -

0 —_ +— — —

2882858 2%¢E3
2022 | 2023 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCI AxJ -~ MSCI China MSCI HK
120 - MSCISG o MSClInda MSCI Indonesia
----------------- MSCI Korea e MSCI Malaysia MSCI Pakistan
----------------- MSCI Philippines - MSCI Taiwan

= MSCI Thailand

80 . .

Apr-2023 May-2023 Jun-2023
MSCI AxJ is a well-established benchmark representing Asia

regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEIl Correlation (2023)

10 largest and most representative
HKEX-listed mainland banks stocks

2,597.53 (As at 30 June 2023)
21.3

22.44 (June 2023)

0.724

0.729

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 29 Jun 2023

HK$50

HK$0.13Mn (As at 30 June 2023)
HK$0.65Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$7,040

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Infarmation for reference onlv

As at 30 June 2023

5-Min Avg. Bid-Ask Spreads (30 June 2023)

HSMBI Futures

CEB Bank 6818.HK 0.58%
Minsheng Bank 1988.HK 0.53%

Bank of China 3988.HK

ABC 1288.HK

CITIC Bank 998.HK

CM Bank 3968.HK

ICBC 1398.HK

PSBC 1658.HK

Bankcomm 3328.HK

CCB 939.HK

Index & Constituents 3-Month Performance (Rebased to 100)
=—HSMBI ——CCB (939.HK)

ICBC (1398.HK) BOC (3988.HK)
——ABC (1288.HK)

120 -

90 . .
Apr-2023 May-2023 Jun-2023

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index

80 A-Shares and 40 HK-listed Mainland

Index Description ) ) )
China H-shares, P-chips, and red chips

Index Level 5,505.10 (As at 30 June 2023)
Index Volatility (30-Day Historical) | 24.7

Index Avg. Day High-Low Range 61.55 (June 2023)
CSI300 Correlation (2023) 0.864

FTSE A50 Correlation (2023) 0.871

5-Min Avg. Bid-Ask Spreads (30 June 2023)

CES120 Futures | NA

CSOP FTSE A50 ETF (2822.HK) _ 0.16%

i 0,
R 0 et S X iShares A50 ETF (2823.HK) F 0.11%

Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.28Mn (As at 30 June 2023)
Average Quote Size HK$1.38Mn (5 Contracts)

Average Bid-Ask Trading Spread| N/A

CES120 & Top Constituents’ 3-Month Performance

(Rebased to 100)

130 e=CES120 Index Tencent CcCB
Liquidity Providers N/A ——Ping An ——— China Mobile

120 A
Transaction Cost* 110 A
Stamp Duty N/A 100 -
Trading Fee HK$5 / contract

90 -
SFC Levy HK$0.54 / contract
f 80 T T

Margin as of 29 Jun 2023 HK$13,790 Apr-2023 May-2023 Jun-2023

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 30 June 2023

CES120 Futures can be used to hedge A-share positions

15



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan  |[MSCI Japan
Information |INTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index  |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJIDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietnam
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
O#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



